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1) Introduction
What is Microsoft Excel?
Microsoft Excel is an electronic worksheet that does a lot more than replace a statistical table or
accountant’s ledger book with its neat columns and rows. Excel can perform just about any mathematical
calculation you want, and changes can be made to your numbers and calculations without having to
painstakingly rewrite the entire worksheet. A worksheet is essentially a large grid that aligns entries in rows
and columns so that it is easy to see which numbers you are working with.
Microsoft Excel can also create charts from your numbers much more easily than you can create them by
hand, and can exchange information easily with other programs such as Microsoft Word, Microsoft
PowerPoint and Microsoft Access so your information can be presented to others in nearly any form you
choose.
With Excel, it is easy to enter information into a worksheet, and then change, delete or add to the
information. You can change and update your data easily. You can organise your worksheets in your
workbook to have worksheets for different tables, subjects or years (for example, you might place all the
worksheets from the Census into one workbook), and then name them so you can locate the information you
need quickly.

What really happens in Excel …
The basic idea of Excel is the ‘workbook’ which contains one or more worksheets.
A worksheet is similar to an accountant’s ledger or spreadsheet, with numbers, text, and calculations lined
up in columns and rows, and each ‘box’ in the sheet is a ‘cell’. BUT, unlike an accountant’s ledger, when you
type numbers into Excel, the program performs the calculations for you. The most important thing about
Excel is how it organises the data we put into it by using COLUMNS and ROWS.
As you can see from Illustration 1 below, columns are labelled with letters of the alphabet and rows are
labelled with numbers. The column and row labels act like street signs in a town – they can help you identify
your current position. In Illustration 1 the ‘active cell’ is in Column A and Row 1 – so its Cell Reference is A1,
which you see in the ‘current cell reference’ in the Formula bar.
There are numerous “Toolbar options” at the top of the worksheet which provide a very wide range of
functions you can perform to the data in your worksheet. The main toolbar options are:
“Home”: Contains the most commonly used features such as font options, positioning of data options,
copying, pasting, etc
“Insert”: Allows you to insert things like summary tables, graphs, pictures and text boxes
“Page Layout”: Contains features like setting page margins, page orientation, defining the print area, and
so forth
“Formulas”: Contains the main list of functions which can be performed on your data such as
summations, counts, averages, etc
“Data”: Contains features such as importing data from other sources, sorting datasets and filtering data
“Review”: Can be used to check any spelling in the worksheet, add comments to cells and setting
protections on datasets, etc
“View”: Allows you to view the spreadsheet in different forms for printing purposes as well as freezing
panes
Most of these Toolbars will be discussed in more detail throughout this manual. Only commonly used
features for data analysis will be addressed.

Illustration 1: A typical excel spreadsheets in Microsoft Excel 2007
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2) The “Home” Toolbar
The home toolbar is the first toolbar listed on the left, and is usually the most commonly used. It is broken into 7
sections which cover:
1) Clipboard
2) Font
3) Alignment
4) Number
5) Styles
6) Cells
7) Editing
A brief description of each is as follows

2.1 Clipboard

The “Clipboard” is used mostly for copying and pasting, although it is just as easy to highlight the relevant area in your
spreadsheet and right click the mouse to bring up the same options. The most common applications involving this
section are to either:
a)

Cut and Paste: Removes the selected data from its original position and pastes it in the new position

b) Copy and Paste: Copies the selected data and pastes it in the new position, leaving a copy in the original
position
Paste Special
When pasting information from one place to another, it is often better to use the “paste special” option, as this will
provide you with more pasting options. Some of the key options include:
a)

Formulas: Maintains any formula which may have existed in the cells which are being copied

b) Values: Only copies the value which existed in those copied cells, thus ignoring any formulae
c)

Transpose: Enables you to transpose the copied cells when pasting – that is, the rows become columns and
vice versa.

See below for an illustration as to where these are located

Some key options of “Paste
Special”:
a)
b)
c)

Formula: maintains the
formula
Values: only pastes the
value – not formula
Transpose: Converts the
paste from rows to
columns, and vice versa

2.2 Font

The “Font”, as its name suggests, allows the user to adjust the font of numbers and text in the spreadsheet. This
section allows for the font type and size to be changed, as well as allowing for text to be converted to bold, italics or
underlined. The background for the cell can also be modified, as to the colour of the text. The final feature, in the
middle bottom, allows for the borders of the cells to be modified accordingly.
Once again, all these features can also be applied by right clicking in a cell/s, and selecting the format cells options
option. The three windows “font”, “border” and “cells” provide the same options and more of a similar nature. See
below for an illustration.

These three windows provide more
options of a similar nature

2.3 Alignment

The “Alignment” allows you to primarily position you text within a cell/s, but always enables you to wrap text and
merge cells. Some more explanation of each is as follows:
a) Horizontal alignment: Allows the user to modify how the text is aligned horizontally
b) Vertical alignment: Allows the user to modify how the text is aligned vertically
c) Angled text: Can convert the text to an angle, but hardly used
d) Indented text: Indents the text either left or right in small indents at a time
e) Wrap text: Enables the text to be wrapped around to a second line, but still staying within that cell. To achieve this,
the cell height will have to be large enough to accommodate this
f) Merged Cells: Merges two or more cells together into one cell. When the button “Merge and Center” is clicked then
the text is also centred.

2.4 Number

The “Number” section allows you to quickly change the way numbers are presented in your spreadsheets. Each of
these features are generally used frequently, and makes it easy to convert numbers to currencies and percentages (if
required), as well as changing the number of decimal places and adopting comma’s to make large numbers easier to
interpret.

2.5 Styles

The “Styles” section has three features, although only the first of these features will be discussed here, “conditional
formatting”. Conditional formatting enables you to highlight values in a dataset, which meet a certain criteria,
enabling the user to identify those values a lot easier. It can be great for editing data and identifying unusual
observations, especially in large datasets.
When you click on the “Conditional Formatting” icon it provides numerous options for highlighting the data, but first
you must select the component of the data you wish to apply the conditional format. The options can be seen in the
illustration below and cover the following:

a)

Highlight Cells Rules: Enables you to highlight any record which is greater than, less than, equal to, etc a
particular value.

b) Top/Bottom Rules: Enables you to highlight the top few values (# or %) or bottom few values (# or %).
c)

Data Bars: Attaches a coloured bar to each cell value, with the size of the bar signifying the size of that cell
value when compared to other highlighted cell values.

d) Colour Scales: Shades each highlighted value, depending on the size of the value, with respect to other
highlighted values.
e)

Icon Sets: Attaches an icon next to the value which indicates the size of the value, with respect to other
highlighted values.

But it is generally easier to create your own new rule and add to or manage it using the three icons at the bottom:
•

New Rules

•

Clear Rules

•

Manage Rules

These options enable you to create a series of formatting rules you can apply to a dataset, tailor made to your specific
needs.

Generally the best
options for creating and
managing rules

When a “New Rule” is selected, then the window displayed below appears, and the user then needs to undertake two
tasks:
1) Choose the rule type from the upper box
2) Create the rule description from the lower box
Trial and error is a great way to practice this feature, and remember, you can adopt more than one rule.

Choose the rule
type here

Create the rule
parameters here

2.6 Cells

The “Cells” section provides a quick and easy way to either insert or delete the following:
•

Cells

•

Rows

•

Columns

•

Sheets

The “Format” icon also enables you to adjust row heights and column widths, as well as hide and unhide rows and
columns.

2.7 Editing

As can be seen from the diagram above, the “Editing” section has 5 icons available. Some brief comments about three
of these is as a follows:
AutoSum

Having clicked on a cell in the worksheet, when you click on this icon, it will then ask you to identify what values in the
spreadsheet you would like to sum. You achieve this by simply highlighting the values and clicking enter. An
important trick to know here is that excel often tries to guess what values you wish to sum, based on which cell was
initially highlighted. For example, if a cell below a column of numbers was initially highlighted, then by default when
you click the “autosum” icon, it will highlight the values in that column above to sum, as a default.
Sort & Filter
Will be covered in the “Data” toolbar in section 6 of this report.

Find & Select
Clicking on the “Find & Select” icon will bring up a range of options with the most useful being the first two options
“find” and “replace”. The “find” option enables you to locate certain text or values in a dataset, whereas the
“replace” option enables you to replace those values/texts with something different. Make sure you highlight the
area of the spreadsheet you are interested in first, before commencing your search.

3) The “Insert” Toolbar
3.1 Introduction to the “Insert” Toolbar
The illustration below shows the Toolbar for the “Insert” menu. As can be seen from this illustration, the toolbar is
divided into 5 sections:
1) Tables
2) Illustrations
3) Charts
4) Links
5) Text
When analysing data, the “Tables” and “Charts” sections are the most commonly used features in this menu. In
particular, the “PivotTable” option is a very powerful tool for producing summary tables from large datasets, and the
Column, Line, Pie and Bar Charts are very useful for producing simple graphical illustrations of what the data
represents.

Great for producing
summary tables

Most commonly used
graphical presentations

The rest of this section will be divided into three sections
1) Producing Pivot Tables in Excel
2) Producing Graphs/Charts in Excel
3) Other useful features of the “Insert” menu

3.2 Producing Pivot Tables
3.2.1 Initial activities before you start producing tables
Before you start producing tables via the pivot table function, it is important you undertake a few steps first to make
sure the data is in the correct format and the right type of analysis is produced. These steps are as follows:
Step 1: Understand your data: In order to save time re-running the pivot table function in excel, it is a very
worthwhile practice to spend a suitable amount of time understanding your data. Some of the basic things you should
be making sure of during this process are the following:
a)

Know what level your dataset is stored at – is it person level information, household level information,
etc
b) Get a feel for the size of the dataset by knowing how many units are in your data – this is generally the
number of rows in the dataset
c) Know what information is stored for each unit (also known as the variables) – it is common that one
column will represent one variable
d) Understand what values can be recorded for each variable - for example, for the variable sex, the
responses could be recorded as Male/Female or M/F or 1/2, etc
e) Know what is recorded if the response for that variable was a “not applicable”, “don’t know” or “nonresponse” – often codes of 9 or 99 get used for these types of responses
Step 2: Make sure your data is in the right format: Whilst the pivot table function is a very powerful tool for analysing
large datasets, it will only work as designed, if the dataset is in the write format first before you produce a table.
Some basic things to check for are as follows:
a)

Make sure you have only one row as the labels for variables, as this is all excel will be able to recognise.
An example of what will and won’t work is:

Won’t work

Will work

Day
1
2

Max temp

Day
1
2

Jan-Max

Jan

Min temp

Jan-Min

Feb
Max temp Min temp

Feb-Max

Feb-Min

b) Make sure there are no separations in the data through blank rows or columns. This is especially
important when you highlight the data using the “select current region” icon as not all the data will be
highlighted
c)

Make sure there are no summary statistics included in the dataset, usually at the bottom of the data –
eg, totals or averages. If these get included in the data to be analysed via a pivot table it will distort the
results

Step 3: Have a clear picture of what the table should look like: A good way of saving time when producing tables in
excel is to have a clear picture of what the final table should look like before you start – even draw it on a sheet of
paper before you start. You need to ask yourself “will this table provide me with the information I need?” – if so,
proceed – if not, modify the table. Knowing what options to select when going through the pivot table feature will be
a lot easier if it is clear what you are trying to produce.

Once you have followed these three steps and are ready to start, highlight your data set using the “Select Current
Region” icon. See “Section 9 – Other Useful Information” on how to add this icon if you don’t have it.
3.2.2 Basic Steps in Producing Pivot Tables
Step 1: Click on the pivot table icon to the far left of the “insert” toolbar
Click here
Don’t click on
down arrow

You only need to click on the icon picture at the top, not the down arrow underneath.
Step 2: Once you have clicked on the pivot table icon you will see a pop-up box which asks you to specify where
the data is which you wish to analyse, and where you would like the pivot table stored. If you highlight the data
prior to clicking on the pivot table icon, the data range should already appear as a default – it doesn’t hurt to
check it is correct though. With regards to where you would like to place your pivot table, it’s often a good idea
to store new tables in new worksheets to keep your analyse in an orderly fashion. See the illustration below.
Should be correct data range if
data highlighted initially

Easier to
keep tables
in separate
worksheets

Step 3: Create the pivot table structure. Once you have clicked ok for where the data is stored and where you
would like the pivot table to be placed, the screen in illustration XXX will be displayed.

It is in this screen where you create your pivot table. On the right hand side of this screen is where you can
click and drag any of the variables in your dataset to create your table. For this example there are 6 variables in
the dataset (Person #, Age, Sex, Weight, Height and Country of Birth). Below the listing of the variables you will
find 4 boxes for creating the table:
•

Report Filter: If you wish to produce separate tables for sub-populations, drag the variable you wish to
create separate tables for into this box. For example, if you wish to create a separate table for males
and females, drag the variable “sex” into this box. More than one variable may be dragged into this
box

•

Column Labels: This box is for the variable you wish to have as the column header for the table. Once
again, more than one variable may be dragged into this box

•

Row Labels: This box is for the variable you wish to have as the row header for the table. Once again,
more than one variable may be dragged into this box

•

Values: This box is explained in more detail in step 4

Variables in the
dataset. Click
and drag below

As you create the
table on the right,
you will see it
appear here on
the left
If you wish to create
separate tables for
sub-populations, drag
that variable from
above to here

Drag the variable you
wish to have as the row
heading above to here

Drag the variable
you wish to have as
the column heading
above to here
Drag the variable
you wish to
count, sum,
average, etc from
above to here

Step 4: Understanding the “Values” box. In the main body of the table, many statistical options are available,
depending on the type of analysis one wishes to undertake. Some of the more popular include the following:
Count: Provides a simple count of the number of observations that fall in that cell of the table
Sum: Provides a summation of the values for a specified variable for all observations that fall within that
cell of the table
Average: Provides an average value for a specified variable for all observations that fall within that cell
of the table
In order to change the type of statistic you wish to compute, simply left click on that variable after you have
dragged it into the “value box”

Left click on “Value Field
Settings” to see what other
options are available

Because weight is a
numerical variable, the
default option is to “sum”
this value. Left click on this
variable to bring up the
window above.

Once you have clicked on the option “Value Field Settings” you should see the following window:

The variable you are
performing the statistical
operation on
The current default option
– in this case summing the
weight
Alternative statistical
functions which can be
performed on that variable

Different formatting
options which will
appear in the table

Simply scroll down the menu in the middle of this window to select the statistical function you wish to perform
on that variable

It should also be noted that more than one statistic can be produced for each cell of the table. For example, if
you wish to compute both a summation and an average for the variable weight, simply drag the variable into
the “Values” box twice and perform a summation on one of the options and an average on the other. You
should see this in the “Values” box when you are finished.

This will give you your
summation
This will give you your
average

3.2.3 Producing tables with percentages
A common form of analysis is to express cell values in the tables as percentages. Three main options exist for
this:
1) Percentage of total: Will provide that cell value as a percentage of the total for all cells in the table
2) Percentage of row: Will provide that cell value as a percentage of the total for that row only in the table
3) Percentage of column: Will provide that cell value as a percentage of the total for that column only in the
table
To employ this option go to the “Value Field Settings” for the statistical analysis of interest and click on the
panel “Show values as”. Currently the default is “Normal”, but you can scroll down to switch this to one of the
three main percentage options discussed above. See illustration XXX below

Click on the panel
“Show values as”
These are the main
3 percentage
options used

3.2.4 Adjusting pivot tables
As expected, when producing a pivot table they don’t always look the way you would like, and you need to modify
them. There is no need to create the pivot table again from the start as the existing one can be easily modified to
make the necessary adjustments.
Any information in the four boxes used to create a table can be changed. As you make the changes you will notice the
table to the left of screen changing as well. Feel free to modify the table
Formatting Pivot tables – talk about this

3.2.5 Grouping Data in Pivot Tables
Pivot tables can be used to group numeric data used in columns or rows. You can group data like age into five-year
groups, commodity items into a higher level of the classification, or individual incomes into ranges.
Grouping data in Pivot tables is straight forward if the data can be grouped into evenly sized groups. The complication
comes with uneven class intervals or open-ended groups such as ’65 +’ for age, or ‘$60,000 +’ for income. Techniques
for overcoming this problem will be discussed below.
Grouping – even class intervals
If you wish to group the data into even class intervals then the process is straight forward. Simply right click on one of
the row labels in the table you have created and it will bring up a window as shown below in illustration XXX. Then
click on the option “Group”.

Right click on any
one of the row
labels in the table

When this window
pops up, click on
“Group”

Having clicked on group, the following window pop-up will appear.

This will be the smallest
value in the data
This will be the largest
value in the data
This is the size interval of
each group

The value that appears in the first box (Starting at), as a default, is the smallest value in the data, whereas the value
which appears in the second box (Ending at), as a default, is the largest value in the data. Both these values can be
changed to make the size of the groups even.
The value in the last box (By) is the size of the groups – this will usually be “1” as a default, so it needs to be changed
to accommodate the needs of your table. In the illustration above, 4 groups of size 5 have will be created; 1-5, 6-10,
11-15, 16-20.
The resulting table should then look like this:

The new 5 year
age groups

A trick for creating age groups
Quite often when you form age groups, you wish to say, group in 10 year age brackets up to 70, and then combine the
remaining ages into one group (70+). The way to achieve this the easiest is to fill in the “grouping” window pop-up as
follows:

And the result it will create the following table

Created will be 7 ten
year age groups plus
the last group “>70”

Grouping – uneven class intervals
If you wish to group values in uneven class intervals, you will have to do this separately for each group. The step
process for doing this for one group is as follows:
Step 1: Highlight the rows you wish to group, right click once, and then click on “Group”
Step 2: Click on the “-” next to Group1, and rename the new row “1-3”
See illustration XXX for how this should look

Highlight the rows
you wish to group

Click on “Group”

Click on the “-”
next to Group1

Rename the new
row “1-3”

You can then follow these same procedures for grouping other rows of different class sizes.
3.2.6 Refreshing Tables
Often after a pivot table has been created, the original dataset used to create the table needs to be modified. If this
occurs, you do not need to recreate the pivot table from scratch. This can be achieved by using the “Refresh” option,
as depicted in the example below. Simply right click on any cell in the table and select the “Refresh” option – this will
immediately update the table.

Click the refresh button here
to update the table

3.2.7 Showing Details
An important part of producing any table is examining the results in the table to see that they make sense. Often
numbers may look unusual or out of place within the table and therefore need to be checked. An effective way of
doing this is examine the records which contributed to that value in the table more closely to see what generated the
unusual outcome. This can be simply achieved via two approaches:
1) Double click with the left mouse button on the cell you wish to examine
2) Right click once on the cell you wish to examine and select the option “Show Details”
Either of these options will automatically create a new spreadsheet within the workbook which lists the details for
only those records that contributed to that cell.

3.3 Producing Graphs
3.3.1 Initial activities before you start producing graphs
Before you start producing graphs, the first thing to consider is the type of graph to produce to best illustrate what the
analysis is trying to show. For this section of the manual, only the following graphs will be covered:
•

Column graphs: These graphs are very useful for comparing sub-populations in data. Examples include,
comparing males and females, different age groups etc

•

Line graphs: These graphs are best used in analysing trends over time, where the line can be used to best
illustrate the change over time. Examples include looking at the population growth of a country over time,
monitoring the CPI over time, etc

•

Pie charts: These charts are very useful for splitting a population into numerous sub-populations and showing
the distribution of each. Examples include showing the breakdown by country of residence for visitors to a
country, the breakdown by religion for a population, etc

•

Bar charts: Like column graphs, these are also useful for comparing sub-populations. The bar charts will have
the bars appearing horizontally in the chart, whereas in a column graph, the bars will appear vertically.

These four options for graphs, represent the most commonly produced graphs in basic statistical analysis.

3.3.2 Guidelines in producing graphs in excel
As a general guide when producing graphs, some basic guidelines should be followed. These guidelines also apply
when using excel. Some of the more important rules which should be adhered to are as follows:
1) Make sure the graph has a clear, self explanatory title
Interpretation of a graph is made a lot simpler with a clear, self explanatory title. Included in the title should be the
population of interest being analysed, the variables used in the analysis, and the reference period. Also remember to
include a reference number if the graph is to be included in a report, so it can easily be referred to in accompanying
text.

Age by Sex breakdown
Graph 1.3: Age by Sex breakdown, Fiji, 2010

2) State the units of measurement used
Also assisting with the interpretation of the graph is information on the units of measurement used in the graph. If
the values are in percentages, then make this clear in the title with a symbol like (%). Likewise, if the values in the
graph are in millions of US dollars, then this should also be specified in the title using something like ($M-USD).
3) Keep the graphs simple

A common mistake many graph producers make is to concentrate on making their graphs look nice, and not focus on
the main objective – “to make the graph clearly depict what the trend in the data is showing”. Graphs in Excel 2007
can be produced in 3-D but this option should not be used as it only distorts information. This is particularly the case
for Pie Charts, but also applies for Bar Charts and Column Graphs. Two dimensional graphs should therefore be
produced.
4) Carefully mark all axis labels
Many graphs produced will possess both a Horizontal and Vertical axis. Make sure each axis is clearly marked to
illustrate what is being presented in the graph. For example, if the numbers on the vertical axis represent
percentages, have this clearly written on the side. Additionally, if the columns represented in a column graph
represent age groups, have this clearly written underneath the horizontal axis.
5) Use scale breaks for false origins
Often information or trends in a graph can be lost due to the size of the values being analysed. This can be rectified by
using false origins which can help demonstrate more clearly trends over time or differences in magnitude between
sup-populations. For example, if we wanted to produce a line graph showing the trend of the CPI over a 2 year period,
and the CPI figure ranged between 103 and 109 during this time, then we can set the vertical axis to only cover the
range 100 – 110 to better illustrate the change. See example below:
Bad example: Difficult to determine trend

Good example: Can clearly see the trend

CPI for Guam, 2009-Q1 - 2010-Q4

CPI for Guam, 2009-Q1 - 2010-Q4
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3.3.3 Basic Steps in Producing Graphs in Excel
3.3.3.1 – Column Graph
As discussed above, column graphs are very useful for comparing sub-populations in a data set. For example, you may
wish to compare the distribution by sex, for each age group category. Having said that, a column graph can also be
used to analyse the one variable, if a simple understanding of the distribution of a variable is all that is required.
Examples of each are provided below.

Age Distribution

Age Distribution by Sex
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The first decision is therefore to determine what type of column graph is required.
Once that decision is made, it is a lot easier to produce the basic outline of the graph by highlighting the required data
first. Knowing how to do this will take practice, but trial and error can be used. Once the data has been highlighted
you can then click on the column graph icon in the insert menu to create the outline. When you click on the column
graph icon, a range of column graph options will be displayed – see diagram XX below for an illustration of how this
looks. It is strongly encouraged to select from the first row of options when making the decision on the type of
column graph to produce. The remaining options which include 3-D column graphs, cylinders, cones and pyramids can
distort the interpretation.

Step 2: Select the
Column Graph option

Step 1:
Highlight the
data

Step 3: Select
the type of
Column
Graph

Highlighting the Data – A few Tips
A discussed above, producing graphs in excel can be made all the easier if you are aware of how to highlight your data
initially. This will take practice, but some examples to guide you for a column graph are provided below. As can be
seen from these illustrations, if just the numbers in the body of the table are highlighted (scenario 1) then the graph
will be produced with no horizontal axis labels, and no legend labels. If the age group categories are highlighted
(scenario 2), then these will be added as the horizontal axis labels, and if the column headings are added (scenario 3),
then these will be added as the legend labels.
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Modifying and formatting a Column Graph
Once the basic graph has been produced, you can click inside the graph which will bring up three additional menus
which can be used to modify and format the graph. These will be found on the main menu to the right, under the title
Chart Tools, and cover the following functions:
Design: Allows you to modify the data being fed into the graph, select from a range of chart layouts, as well as
select from a range of chart styles. As different chart layouts and styles are selected, you will automatically see a
preview of that option to help you decide if that is your preference.
Layout: The main features in the Layout Menu enable you to format your graph more, in particular with respect to
adding titles, axis labels, legends, etc. You can also use this menu to modify the horizontal and vertical axis, as
well as add gridlines.
Format: This menu enables you to further format the graph by placing borders around the graph and modifying
the text style to make the graph look more appealing.
When modifying and formatting your column graph, the graph preview will be updated, so you can see immediately if
you are happy with the change. Trial and error using these three menu options is the best way to learn how to fine
tune your graph so it looks exactly the way you would like.

Three new Chart Tools menu options;
Design, Layout and Format

3.3.3.2 Line Graph
The Line graph is most frequently produced to analyse trends over time. A simple analysis of just the one trend line
can be produced over time, or comparisons of more than one trend over time can be generated. See below for
examples of each for a CPI series.
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As with the Column Graph, highlighting the appropriate data initially can make production of the Line Graph a lot
simpler. In scenario 1, only the series numbers were highlighted, so no horizontal axis labels and legend appeared in
the graph. In scenario 2, the quarter time periods were highlighted, so these were automatically added to the
horizontal axis labels, and in scenario 3 the column headings were highlighted, so these were automatically added as
the legend.
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Modifying and formatting a Line Graph
As with the Column Graph, once you have produced the basic outline of the graph, clicking inside the graph will bring
up three additional menus which can be used to modify and format the graph. The general functions of these three
menus will be the same as the column graph, with some slight modifications as the graph structure is different
Users new to producing line graphs are once again encouraged to use trial and error in determining what functions
are best for them when modifying and formatting the graph. Remember to view the graph preview each time for an
easy way to see what each feature does.

3.3.3.3 Pie Chart
The Pie Chart is most commonly produced to show how a population can be split into sub-populations, and as such
which sub-populations are the larger in size. To make the pie chart meaningful, care needs to be taken in determining
how many sub-populations should be included. Having too few will not make for interesting analysis, whereas having
too many will make for the interpretation to be too complicated. An example of each is presented below to illustrate
this point.
a) Example of too many Pie pieces

b) Example of too few Pie pieces

c) Example of a good amount
Visitors to FSM by country or
residence, 2010

Visitors to FSM by country of
residence, 2010

USA
Philippines

USA

Other Asia

Other

Micronesia
Australia/NZ
Other

How to achieve a suitable number of pie pieces

Firstly, the question needs to be asked as to what is a suitable number of pie pieces. As mentioned above, if you have
too few (“b” above), the analysis is not all that interesting, whereas too many (“a” above) results in the analysis being
too difficult to interpret. It is commonly considered that no fewer than 4 pie pieces should be included, and any more
than 15 pie pieces will make interpretation difficult.
If you are therefore analysing a variable such as marital status, via a pie chart, then you usually wouldn’t have to
modify the data too much. Marital status is usually already categorised into 5-6 main groups, so creating a pie chart
for this variable should be straight forward. On the other hand, if you were looking at a variable such as the one in the
examples above, “visitors by country of residence”, you could well have over 50 countries of residence. The strategy
here is to group some of these categories using common sense so interpretation of the data is made easy. For
example, in the example of a good amount of groups above “c”, the USA is the largest country providing visitors to
FSM, so they are left as a group by them self. Philippines is also considered significant enough to be by itself, so that
country remains as a group by itself. All other Asian countries are not considered significant, so they are grouped into
a group entitled “Other Asia”. Each Micronesia country outside FSM is not considered significant enough, so these are
grouped also, and so forth.
Other information to include in a Pie chart
It is also common practice to include values in the pie chart to illustrate their actual value. The two most common are
the raw counts themselves, and percentages. An example of both using the example above is provided below:

a) Expressing the numbers as raw numbers

b) Expressing the numbers as percentages

Visitors to FSM by country or
residence, 2010

Visitors to FSM by country or
residence, 2010

81

4%

199

11%
512

27%
USA

USA

Philippines

Philippines

Other Asia

Other Asia

Micronesia

437

Micronesia

23%

Australia/NZ

Australia/NZ

Other

Other

311

329

17%

18%

Adding the labels in Excel 2007
To add the labels to the Pie Chart, click inside the graph then click on the “Layout” menu. Click on the “Data Labels”
menu and choose your location.

Step 1: After clicking inside the
graph, click on the Layout option

Step 2: Choose
the option you
prefer to display
the numbers –
“Outside End” is
often preferred

Changing to percentages
If you wish to convert the numbers to percentages, simply click on the option at the bottom of Data Labels entitled
“More Data Label Options”. The window below will appear and all you need to do is to select the “Percentages”
option.

If you want Percentages
displayed on the outside?

Step 1: Tick
“Percentage”
box here

Step 2: Mark
the option
“Outside End”

3.3.3.4 Bar Chart
The Bar Chart is often used to undertake a similar style of analysis as that of the column graph. That is, it is a useful
tool when it comes to comparing sub-populations in a data set. And it can also be used to display the simple
distribution of one variable. Here’s an example of each:

a) Example of univariate analysis

b) Example of bivariate analysis
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As with the Column Graph, when the data has been highlighted (using the same principles presented in 3.3.3.1), and
you click on the Bar Chart option, the following Bar Chart options will be displayed. The top three are the most
common.

The three main
options used

All the
options
available
with a
Bar Chart

Useful Tip
NB: For all graph types, changes can be made to
features such as font size of numbers/text, and the
colours/patterns displayed in the graph. It is
recommend to often modify the font of numbers and
text in your graphs, to make it clearer when viewing.
However, be careful when making adjustments to the
colours because if a bad choice of colours is made, it
can make interpreting the graph more difficult.

3.4 Other useful features of the “Insert” menu
Although there are other insert options available in the insert menu, they are not as important when analysing data in
excel. However, this section will briefly touch on a couple of the other menu groups available in the “insert menu”,
namely:
a) Inserting Illustrations
b) Inserting Text
3.4.1 Inserting Illustrations
Within the sub-menu inserting “illustrations”, four options are provided which cover the following:
1) Picture: Enables you to insert a photo, stored anywhere within your computer. Simply click on the “Picture”
icon and locate where the picture is stored and hit enter.
2) ClipArt: Enables you to insert a “clipart” photo from a large selection of pictures covering a wide range of
topics. To locate the clipart of your choice, simply click on the “Clip Art” icon and do a search on the right
hand side of the screen for various options.
3) Shapes: Enables you to insert a whole range of shapes, arrows, lines, brackets, etc in your excel file. To see
they range of options, click on the “Shapes” icon and make your choice. The size of the shape can be
modified once it has been inserted in the excel file by simply clicking and dragging on the small circles and
squares around the outline of the shape.
4) SmartArt: Enables you insert a range of graphic options which can be used for flow charts, tree diagrams etc,
but this is rarely used in excel.

Each of these four insert “illustrations” options can be viewed below

Four different “illustrations”
which can be inserted

Useful Tip
Pictures and Clip Art can be inserted into
the backgrounds of graphs you produce,
but this is generally not recommended, as
it often makes it less clear in viewing what
the graph is trying to display

3.4.2 Inserting Text
Within the sub-menu inserting “text”, six options are provided which cover the following:
1) Text Box: Enables the insertion of a text box which can be used to insert small amounts of text into the excel
file to clarify information.
2) Header & Footer: Enables the insertion of a “header” and “footer” for each page of the excel file. As soon as
this icon is clicked, you will notice a small box appear on each page top and bottom, for inserting the header
and footer text. This can be useful when printing excel files. When you click inside these boxes, you will be
provided with a wide range of options which let you insert things like, page number, current date, file name,
etc.
3) WordArt: Enables you to insert fancy text to enhance the presentation of your file. Simply click on the icon
and choose the WordArt.
4) Signature Line: Not relevant.
5) Object: Enables you to insert objects into the excel file. Simply click on the “Object” icon and choose the
object of interest. A good use of this feature is if you wish to insert a mathematical equation into the
spreadsheet to show how a formula was derived, after clicking on the “object” icon, choose “Microsoft
Equation 3.0” and then use this feature to create the formula.
6) Symbols: Enables you to be able to insert a whole range of symbols into the excel file. It can be very useful if
you wish to enter a symbol which can’t be located on the keyboard.

Each of these six insert “text” options can be viewed below

Six different “texts”
which can be inserted

4) The “Page Layout” Toolbar
4.1 Introduction to the “Page Layout” Toolbar
Illustration X below shows the Toolbar for the “Page Layout” menu. As can be seen from this illustration, the toolbar
is divided into 5 sections:
1) Themes
2) Page Set-Up
3) Scale to Fit
4) Sheet Options
5) Arrange
As the purpose of this short user manual is on the analysis side of data, only a short explanation of what is in each of
the first 2 sections is provided throughout this chapter

Themes

Page Setup

Scale to Fit

Sheet Options

Arrange

4.2 Themes
This section of the Page Layout menu provides the user with the opportunity to change the overall format of
spreadsheet to create a certain theme. The first icon “Themes” gives you a range of themes to select from which have
already been pre-assigned a set of colours, fonts and effects.
If you would prefer to create your own theme, then simply use the other three icon buttons “Colours”, “Fonts” and
“Effects” to choose the nature of a tailor made theme. The three different features of a theme have the following
impact on your spreadsheet:
•

Colours: Modifying the colours of a theme will change the colours selected in any graphical information
provided in the excel file, as well as changing the colours provided in any “Shapes” or “SmartArt” in the file.
It won’t change the colour of the text however.

•

Fonts: Modifying the font will simply set a new font style for all text in the file, but won’t modify the font size.
Modifying font size needs to be done separately

•

Effects: Modifying the effects will simply change the shadow and border outline of things like “Shapes” and
“SmartArt” throughout the file.

4.3 Page SetUp
This section of the Page Layout menu provides the user with the a set of features which are great for modifying the
manner in which excel files will be printed out. As can be seen below, there are seven main features provided, with a
brief explanation of each to follow.

The Page Setup sub-menu has seven
main options to chose from
4.3.1 Margins
The “Margins” icon when clicked on enables the user to specify the width of margins when printing out files from
excel. There are three default options provided which include “normal”, “wide” and “narrow”. On top of this, the
margins can be customised to a particular size, depending on user requirements.
4.3.2 Orientation
The “Orientation” icon when clicked on enables the user to chose between a portrait and landscape format when
printing. Portrait will be longer from top to bottom, whilst Landscape will be longer from left to right.
4.3.3 Size
The “Size” icon when clicked on enables the user to match a certain paper size when it hits the printer. Given
different countries have different paper sizes, this feature can be useful for the traveller.
4.3.4 Print Area
The “Print Area” icon enables the user to specify which part of the excel file you wish to print. To use this function
simply highlight the area in the spreadsheet you wish to print and then hit the “Print Area” icon, and select “Set Print
Area”. When you then print the file, only the selected area will be printed. This selected area will remain highlighted
until it is “cleared”. In order to clear the selected area hit the “Print Area” icon and select “Clear Print Area”
4.3.5 Breaks
The “Breaks” icon enables the user to insert and remove page breaks in the file when printing. In order to set a page
break, go to the cell in the spreadsheet where you would like it to be, click on the “Breaks” icon, and select “Insert
Page Break”. You should see a dotted line in the spreadsheet indicating where the page break will be. To remove the
page break, simply go to the same cell in the sheet and click on the “Breaks” icon, and select “Remove Page Break”.
4.3.6 Background
The “Background” icon simply enables the user to have a photo in the background of their spreadsheet if they desire.
This can be achieved by clicking on the “Background” icon and selecting the appropriate photo in your files.

5) The “Formulas” Toolbar
5.1 Introduction to the “Formulas” Toolbar
Illustration X below shows the Toolbar for the “Formulas” menu. As can be seen from this illustration, the toolbar is
divided into 4 sections:
1) Function Library
2) Defined Names
3) Formula Auditing
4) Calculation

This chapter will only address the Function Library only, as the other sections are not frequently used, and out of
scope for this manual. This section will be split into three parts:
1) The Insert Function fx
2) The AutoSum ∑
3) The remaining icons

5.2 The Insert Function fx
The “Insert Function” option when clicked provides access to all functions available in excel 2007. When clicked, the
window below appears which offers a couple of different ways of searching for the function you may wish to apply to
your data:
a)

Use the search option to type in a brief description of the function you would like to perform, then hit the
“GO” button to bring up some possible options

b) Select a category from the second bar, to bring up a list of functions which fall under that category and
choose from there
If you adopt approach (b), the first two options can be quite useful as they provide:
i)

Most Recently Used – which generally contains the functions which you have a preference for

ii)

All – which provides a complete list of every function excel 2007 has to offer

To locate the function you
wish to use you can either:
a) Use the search option to
locate the function you would
like to use
b) Select the category and
then choose from the
functions within that
category
Note: A brief description is
provided here for the option
highlighted above to make
selection easier

5.3 The AutoSum ∑
The “AutoSum” function can be a quick way to carry out one of the following calculations:
•

Sum: Sums the highlighted values

•

Average: Provides an average for the highlighted values

•

Count: Counts the number of numeric values in the highlighted area

•

Max: Provides the maximum number in the highlighted cells

•

Min: Provides the minimum number in the highlighted cells

If a row of cells is highlighted, then the summary statistic above will be provided in the first empty cell to the right of
these cells
If a column of cells is highlighted, then the summary statistic above will be provided in the first empty cell underneath
this column of cells
If an array of cells is highlighted, then the summary statistics are provided below each column, for that column only.

5.4 The remaining icons
The remaining icons:
-

Recently used

-

Financial

-

Logical

-

Text

-

Date & Time

-

Lookup & Reference

-

Math & Trig

-

More Functions

are simple ways of searching for a function within each of the selected topics. Clicking on these icons will bring up a
list of function options relevant to that topic.

6) The “Data” Toolbar
6.1 Introduction to the “Data” Toolbar
Illustration X below shows the Toolbar for the “Data” menu. As can be seen from this illustration, the toolbar is
divided into 5 sections:
1) Get External Data
2) Connections
3) Sort & Filter
4) Data Tools
5) Outline

This chapter will only address “Sort & Filter”, as this is the most crucial section for analysing data.

6.2 The “Sort” icon
The sort feature is a very powerful tool to sort datasets, in particular large datasets. The sort feature enables sorting
by numerous variables, although its more common that just the one variable is chosen to sort the data with. In the
case of two variables being chosen, the data will initially be sorted by the first variable listed, and then within each
unique value for the first sort variable, the data is then sorted by a second variable. For example, in the illustration
below, the data is being sorted by “sex” and then “age”, so initially the process will sort the data by sex, and then
within each sex category, sort the data by age.
The sorting options are different depending on the type of variable being sorted. The two main scenarios are:
•

Numeric variables – the data is sorted by largest to smallest, or vice versa

•

Character variables – the data is sorted alphabetically, A-Z or Z-A

Column headings
Normally the dataset will have column headings to signify what each column represents. If this is the case, then make
sure you tick the box “My data has headers”. Excel should have this appear as a default if the data has headings. If
there are no headings on the columns of data you wish to sort, then leave this box unticked.
When choosing the variable to sort your data, if column headings exist, then the column headings will appear in the
pop-up window as the “sort by” options. If column headings don’t exist, then the column label “Column A”, “Column
B”, etc will appear as the “sort by” options.
In the illustration below, column headings existed in the data, so the variable names “sex” and “age” appear as the
“sort by” option. It’s the down arrow next to these variable names that you click on to bring up the list of all variable
names available for sorting the data with

Sorting right to left
By clicking on the options button below, you can sort the data from left to right, but it is a lot more common to sort
data from top to bottom.

Adds levels
to the sort
procedure

Deletes
levels from
the sort
procedure

The variables
chosen to sort
the data by

Make sure this
is ticked if you
have column
headings

The sort options.

6.2 The “Filter” icon
The filter icon enables you to filter out observations in a dataset so that only those observations which meet a certain
criteria are kept. It is important to note this feature doesn’t remove those observations from the dataset, it merely
hides them from view temporarily.
In order to use the filter feature, start by clicking inside the dataset, and then on the filter icon, which will result in a
down arrow appearing next to each column heading – see below for an illustration.

These down arrows appear when
the “filter” icon is selected

Once the down arrows appear next to each variable name, the next step is to determine how you would like to filter
the data. If you would like to filter the data such that only people aged 5 and 6 are kept, then click on the down arrow
next to the heading for that variable “Age” – you will notice all boxes are ticked for each Age category (see below).

You can then un-tick each box except for boxes 5 and 6. The easiest way to achieve this is to firstly un-tick “Select All”,
which will un-tick all the other boxes, and then tick on 5 and 6.

Click here for more
filter options
Click on the boxes to
filter observations with
those values in and out of
the dataset:
Ticked = kept
Unticked = removed

As illustrated in the diagram above, there are more filter options available if you click on the “Number Filters” options.
See below for a diagram of other filtering options that are available for number variables.

Lots more
filtering options

7) Other Useful Information
7.1 Selecting data in Excel
There are many times when analysing data that we need to highlight the entire dataset. For small datasets
this is often quite straightforward by simply clicking and dragging the mouse. For large datasets however
this can be a tiresome task if you need to do it quite often.
There is a simple way to highlight large datasets with the use of a clever icon referred to as “select current
region”:
(Select Current Region icon)
This icon is not usually a default icon which can be found on one of the main toolbar menus so it needs to be
added. A good place to store this icon if you use it a lot is in the Quick Access Toolbar at the top of the
worksheet
Quick Access Toolbar

This icon can be added by right clicking the Office Button to the left of the Quick Access Toolbar:
(Office Button)

Then select Customize Quick Access Toolbar
Choose this option

The following window will appear, and then you follow the four simple steps below.

Step 1: Select “All
Commands”

Step 2: Scroll down
and select “Select
Current Region”

Step 3: Hit the
“Add” button in
the middle

Step 4: Hit “OK”

The Select Current Region icon will now appear in your Quick Access Toolbar
Here

To use this icon, click on any cell in the dataset which contains information, then click on the Select Current Region
icon, and it will automatically highlight all the data linked to that cell.

A couple of useful tips
Tip 1: Make sure there are no blank rows and blank columns associated with the dataset you wish to highlight. If
there are blank rows and columns, you will end up only highlighting the data fully attached to the point in the dataset
which you click on. That is, the information on the other side of the blank row or column will not be highlighted.
Tip 2: Make sure no summary statistics are attached to the data (often located at the bottom of columns) such as
totals or averages, as these will also be highlighted in the selected region when this icon is clicked. If you wish for
them to be excluded, inserting a blank column between the main data and the summary statistics will achieve this.

7.2 – Understanding the “$” symbol in formulas
When using formulas in excel it is often the case that you will wish to copy these formulas to other cells, rather than
having to re-type them again. When this is the case, it is often useful to use the “$” symbol in from of a cell indicator
to fix that cell indicator to be the same value, regardless of where you copy the formula.
For example, if the following formula in a cell C2 is:
= B2 / B7
Then if this formula is copied down to the cell below (C3), the formula will become
= B3 / B8
But if you wanted the formula for cell C3 to say
= B3 / B7 (ie, the B7 stays fixed)
Then the best way to achieve this is to put a $ symbol before the 7, in the C2 formula, and then copy down. You will
then end up with the following two formulas in C2 and C3:
C2
C3

= B2 / B$7
= B3 / B$7

A good example where this is useful is in calculating percentages for a column, with respect to the column total. See
below for an example of this.

To produce the percentage
contribution of B2 to B7, and
store it in C2, then simply
type “=B2/B7” in the cell C2
and store it as a percentage.
The result is 11%.
If you then copy this formula
down you will get the following

Why does this happen? Because in cell C3, the formula becomes “=B3/B8” and there is no B8 value. The preferred
approach is as follows:

Notice the $ symbol now?
If you instead type “=B2/B$7” in
the cell C2 and store it as a
percentage. The result is still 11%.
If you then copy this formula
down you will get the following,
which is what you want

Why does this happen? Because in cell C3, the formula becomes “=B3/B$7”, so the B7 component of this formula gets
locked in.
It works when copying formula across the page also

It works when copying formulas across the page also
If you wish to copy a formula across the page, and have a component of the
formula stay fixed on a particular cell, then simply put the $ symbol in front of
the letter which indicates the column that value is from. For example, if you
wish to copy the following formula along a row
= C3 / B3
But have the formula stay fixed on the cell B3, then change the formula to:
= C3 / $B3

7.3 – The benefits of “vlookup”
Often data files contain codes for some variables instead of providing a description of what that variable response
may refer to. This is often done to save large amounts of time during data entry. A good example to illustrate the use
of codes is for the variable sex, where often the value “1” gets entered for males, and “2” for females.
However, when it comes time to analyse the data, often the description of the variable is more preferable. There are
tedious ways to add the description for a coded variable into a dataset, but a much quicker way of doing this,
especially for large datasets, is through the use of the “vlookup” function.

In the example below, a dataset is created for a variable (marital status) which has three possible response codes; 1Married, 2-Single, 3-Separated. Only the code (column A) was entered during data entry to create the dataset, but it
is now desirable to have the dataset store the description as well. In order to do this, simply add the array that
contains the link between the code and the dataset over to the side of the data (D2:E4), and type the following
command next to the first code value to add the description next to the code:
=VLOOKUP(A2,$D$2:$E$4,2)
as entered in cell B2 below.
The code
values in the
original data

Example of the
formula to apply
“vlookup” function

This array contains
each code value and
the corresponding
description

When you hit enter and copy this formula down for the remaining observations, it will add the description for each
observation as illustrated below.

When the formula is copied
down, these code descriptions
will be added to the data

The way the formula works is as follows
=VLOOKUP(A2,$D$2:$E$4,2)

VLOOKUP:

is simply the excel function you are applying

A2:

represents the code in the data you want to attach the description to

$D$2:$E$4:

are the cells which hold the array that link the code options with their descriptions

2:

is the row in this array that you wish to have inputted in the description column

